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(Disclaimer)

This eBook is designed to provide information about the subject
matter covered, distributed with the understanding that the authors
and the publisher are not engaged in rendering legal, accounting, or
other professional services. If legal advice or other professional
assistance is required, the services of a competent professional
person should be sought.

Every effort has been made to make this eBook as complete and
accurate as possible. However, there may be mistakes both
typographical and in content. Therefore, the texts should be used
only as general guides and not as the ultimate sources of the subject
matters covered.

The authors and the publisher shall have neither liability nor
responsibility to any person or entity with respect to any loss or
damage caused or alleged to be caused directly or indirectly by the
information covered in this eBook.
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A. Introduction

There is a lot more you can do with a USB flash drive other than
storage and data transfer. The latest USB flash drives offer ample
space and ultrafast data transfers for multiple desktop applications,
hi-definition media files, as well as routine data transfers. The top ten
USB flash drive tips help you get the best use out of your USB flash
drive.

Firstly, did you know that there are a host of portable applications
that can be stored on USB flash drives and used from USB flash
drives without being installed on a computer or portable device? We
show you how to setup an MP3 player with your collection, handle
email between computers, and access productivity apps including a
full office suite, for free.

Of course using a USB flash drive is not without risks, unless you
know how to set it up properly. We explain how to format a drive with
the NTFS file system, protect it from viruses and get the jump on
common concerns like data corruption.

To personalize your use of your USB flash drive, we’ll also show you
how to customize your desktop and then take it with you to any PC.
We’'ll also explain how to set up a Recycle Bin function on a USB
flash drive.

USB flash drives are also great maintenance tools for your computer.
They can be used for disk usage analysis and even to install an
operating system!

Ontop USB flash drives, with TurboJet technology, have the speed
and reliability you need to carry out these useful tasks.
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1. Turn a USB flash drive into bootable media

If you still think that pen drives are used only to store and carry data,
you may need to think again. Netbooks and other MIDs are
fantastically convenient devices, but how do you install operating
systems on them without an optical drive? The solution? A USB flash
drive!

A USB flash drive with low read and write speeds will work slower than

an optical drive but Ontop USB flash drives with TurboJet technology
give you greater speed, making installations quick and reliable.

Preparing the USB drive

Before you get started, make sure you have access to a Windows
Vista or Windows 7 machine.

Connect the USB flash drive to the USB port and follow the steps
below:

Click Start > Accessories and hover on Command Prompt.

48 —t I =

| Ease- of Access »
System Tools »
Tablet PC »

= Calculator

[z».. Command Prompt

e |
(A

Connect to a Network Project
Notepad
Paint

Remote Desktop Connection

Perfo

id

Y o P
P el

Run

2

Snipping Tool
Sound Recorder

)

Right click on the Command Prompt and select Run as
administrator.
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" Open
Ne P

2= Connecttoa ) ]
Open file location

7' Notepad
| Paint ¢ Run as administrator
‘& Remote Desktop @ Scan cmd.exe
Run 8 Addto archive...

¥ Addto "cmd.rar”
Compress and email...

, Snipping Tool

3
'L Sound Recorder
9 Compress to "cmd.rar” and email

Upload Files Using SAXFile...

Sync Center

4 Welcome Centel

M Windnwe Fynlard T e S, C—

Type ‘diskpart’ and press the Enter key. This will initiate the built in
Windows disk partitioning utility.

«7137)
t Corporation. N1l rights reserved.

‘'t version 6.1.7137
ght <C) 1999-2088 Microzoft Corporation.
y conputer: RE-DELL-VIN7-RC

DISKPART>

Type 'list disk' and press the Enter key. Identify which disk is your
USB flash drive.
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8 Adminstrator Command Prompt - deskpart D

icrosoft v ' 1.71371) -
;opyright » 3 crosoft Corporation

- \Window

icrosoft | version 6.1.7137
opyright V2088 Microsoft Corporation
Dy computer (- PELL-VIN?-RC

DISKPART> 13
sk BER . u Size Free

B 1024 Kb

U ) U )

U ) U )

4B I )

) U )

L) U )

3 » 8B U )

Di 7 7848 NB L )
DISKPART >

In this example, disk 7 is my USB flash drive so | will type 'select disk
7' and press Enter.

-
= Adrmerustratorn Command Prompt - dakpant
C:Windows\aystend2 ddiskpart
oft DiskPart version &
1999
compater: RE-DELL-V
MSKPART List disk
Disk E88 Status
Line

Media
Media

novw the selected disk.

DISKPANRT

Type 'clean’ and press Enter to clean the connected USB flash drive.

7 =
B Admenstraton: Command Prompt - diskpart " -
opyright <CO 1999-2808 Ni ] Corporation. a
On computer: AE-DELL-VIN?7-RC

DISKPART> list disk
¢« HBR Status Size Free Dyn Gpt

Online 1397 GB 1824 KB
No Media B 4]
No Media o8B
No Media J 4
No Media 3 4]

No Media 4] 4]

k

k

k No Media 4]
K €

F Online 7848 NB 4]

DISKPART> select disk 7
Disk 7 is now the selected disk.
DISKPART> clean

kPart succeeded in cleaning the
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Type 'create partition primary’ and hit Enter.

r
& Admenistrator: Command Prompt - dakpan — v

Dizk Status Size Free
Dis Online 1397 GR 1824 KB
Dis No Medi a8 a8
Dis . No Medis eBb LI )
Di 3 No Medi UL L )
Disk ¢ No Medi " 88
Disk ¢ No Medis (4 g8
Dis No Medi 0 I
Disk 7 Online 78460 MB ?B

DISKPARID> select disk

nov the selected disk
DISKPART> cloan
DishPart succeeded in cleaning the disk.

ART> create partition primary

succeeded in creating the specifi partition.

Type 'select partition 1' and press Enter.

A
B Admenastrator Command Prompt - diskpan U -
3 o -
3 2]
k J L]
k 4 . 1
kS o
13 i
Disk 7048 ND
DISKPART sel (4
Dizsk 7 iz now the selected disk.
DISKPART ¢clean
DiskPart succeeded in cleoaning the
DISKPART > create partition prinary
DizskPart succeeded in creating the specified partition.
DISKPART> select partition 1
Fartition 1 is now the selected partition
KPART > -
\ J

Type "active’ and press Enter to make the selected partition active.

B Admenstrator Comemand Prompt - diskpart _—

No Media aB
No Media LU
Online 7848 nB

now the selocted disk.
DISKPART> ¢ lean
DiskPFart succeeded in cleaning the disk

DISKPART > create partition primary

DiskPart succeeded in creating the specified partition.

DISKPART> zelect partition 1}
Partition 1 i2 now the selected partition
DISKPART > active

DiskPart marked the current partition as active

D] SKPART > :
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Type 'format fs=fat32' and press Enter to format the partition using
the FAT32 file system.

- - - + - -

B Adminstrator: Command Prompt - diskpart O -

To assign a drive letter, type 'assign' and press Enter.
Type 'exit' and you are done!

Once you have successfully executed all the steps mentioned above,
you have turned your USB flash drive into bootable storage media.
You can even still use the flash drive for storing data as per usual at
the same time!

To get it ready to install an OS, put the operating system DVD in a
computer’s DVD drive and copy all the files from the DVD to the USB
flash drive. If you have an image of the OS instead of a DVD, use a
third party program like MagiclSO to mount the image and copy all the
files to the USB flash drive.

To use the USB flash drive as an installation media, set the first boot
device to USB flash drive from the BIOS and then go forward with the
installation just as you would if you were using the DVD!

Ontop’s USB flash drives with TurboJet technology can be used as fast
and reliable bootable media devices.
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2. A recycle bin for USB flash drives

iBin is a small application that works as a portable Recycle Bin for USB
drives when they’re connected to a computer (PC, notebook, netbook,
etc). iBin is compatible with all versions of Windows and can be used
with various removable storage devices.

To install iBin on your Ontop USB flash drive, download the iBin zip file
from this website to your USB flash drive.

= iBin (1).zip - WinRAR

Fle Commands Favorites Options Hep

AW HWD ¥

Add ExtractTo  Test View Delete Whzard Info Comment

m ; Bin (1).2ip - ZIP archive, unpacked sze 802,005 bytes V.
Name € Size Packed Type
v B Folder
%]Crcotwc Common License,rtf 55,243 12,029 Rich Text

=2 8in User Guide.pdF 523,760 477,881

223,002

Sedact al Chri+A
Add files to archive Al+A
Extract to the spaciied folder

Test archived files AR+T
View fie Ak+Y
Delete fles Del
Repar achive Al+R
Extract without corfirmation  AR+W
Show nformation Ak+1
Passmord Ci+P
Add to Favorkes... Ctri+F

Create a new folder

View & »

Sort by »
$ = Change drive D » )
E3™Q Selected 223,002 bytes i 1 Fle YoEalB02;005 bytes in 3 files

Extract the zip file in the usual way.
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Extraction path and options @

Destination path (will be created if does not exist) Display
T R v
Update mode S (@ Desktop Al
() Extract and replace files % () My Documents =
() Extract and update files = ¢ My Computer
O Fresh esisting files only @ <o Local Disk (C)
# [l RoboForm2Go (D)
Dvemwrite mode i) ". t?gl ::; gil F)
- C7 R § : nve
© Ask before overwrke xRaw ] Femovable Disk (G:)
O Overwrite without prompt 4 S TKArenaVideos on Gms1\S
() Skip existing files # ) Shared Documents
) Admin's Documents
Miscellaneous 4 < GMail Drive
ROy #-) Administrator's Documents
‘ # ) Parag's Documents
[] Do not extract pathnames % %3 My Network Places
[T] Clear attribute ""Archive" ) 2010an 3
[] Keep broken files PO L s |
[ 0K ] [ Cancel ] [ Help ]

E S Home use cost saving.doc
Microsoft Office Word 97 - 20,,,

30 KE

= | Microsoft Office Word 97 - 20, .,

— KBafd

] = e
® | Microsoft Office Word 97 - 20,,,

homeusebusiness3.doc

iBin.exe

Double click on the iBin.exe file.

The utility will create a container in

the USB flash drive’s root folder to store deleted files. When you install
iBin on the USB flash drive, it can be accessed from the system tray of

your Windows operating system.

tice Word 97 - 20...

£ =

[ ) ezt

When Big brothers behave like

= | Shanzhai.doc

ce Word 97 - 20

1 1Bin.inl
. ¥ Conhiguration Settings
e
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File Edit View Favorites Tools

Help

@ Back ~ \.y) " /j\' Search {; " Folders v

Address || G:\iBin

Eve trainer on my lap.doc
Microsoft Office \Word 97 -

25KB

o 74

File and Folder Tasks

€

20...

i

j Make a new Folder

&) Publish this folder to the Futureofmobileadvertising.doc

€]
‘ I

web Micrasoft Office \Waord 97 - 20...
k& Share this folder 2B
j How to reset Windows XP

password using a USB Flash dr...

Microsoft Office Word 97 - 20...

Other Places

M

Now that iBin is installed, when you delete a file or folder from your
USB flash drive, iBin pops up with a message to give you the option to
delete the file permanently, or put it to the iBin so that it can be
retrieved, if required in the future.

. 3.1diots, POVDRIp. avi @ 5 Adam rivals Apple tablet.doc
Kantaris Video File —=
; 713,990 KB | — | 29kB

Microsoft Office Word 97 - 20...
=3 AutoRun.inf
- Setup Information
1KB

@J

Rich Text Format
S4 KB

Creative Common License. rtf

Do you wish erase the data permanently or dump it into the iBin?

. Behind_Enemy_Lines.avi
' Kantaris Video File
715,506 KB
Gmail - Fw_ Registration for 1S4
¢ 2010 summit.pdf
! PDF-XChange Viewer Document

B Confirm Data Erasing EI @

[ Erase it

| [ Coent ]

Dump into Bin

le

J"THJ
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To take a look at what’s in the iBin at any time, click on the iBin icon
from the system tray. The Dumping Management window will pop
up, showing you all the deleted files that are being stored on the USB
flash drive, just in case you change your mind. Just like the Windows
Recycle Bin, you can empty the iBin completely.

B Bin Dumping Management E] 3 g

| Dumping Management

M TH - .
Using 0 MB of 382 M8 allowed in ERROR [G:) Open Bin Conlainer |

Dala Nare SceiMl) Erased n

Y Eye traner on my lsp doc 002 08/Feb/10

\ F scebook mdnovenber report doc 003 08/Feb /10

() Futueoimobleadvestiong doc an3 08/Feb/10

) HinduGod a2 an Fhene app doc ik, 08/Feb/10

1) How to reset Windows X passward using a USB Flash drive doc 003 08/Feb/N0

Dala etated from

4] l Select A J | Cewdatoselected | 8§ | Recycle Data Selacted J

The iBin Custom Options window allows you to setup your own
preferences. If you wish to increase or decrease the space limit of the
iBin container, just move the slider to set the size limit to be anything
from 1 % to 50% of the total free space on the USB flash drive.
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B iBin Custom Options

1| Custom Options

Delels Action Tocks
) Cenfrm O Erase © Dump [ Set a start up command in G: \Autorun.inf J
Pesiosg Dl Confict l Aemove Bin installahon from device I
O Duplicate O Dverwite () Skip
[ Captute delste sction wandow detsis J
Space Lk
| 10 % of the G: dnive
v capacky [392MB) Erasing Methods
Detect DEL Window [V] Activate Hotkeys
AutoClaans

) . Win + Del - diect DUMFING of the data selacted
OWhenthe Binstat: O When the Bin s ful Win + E - direct ERASING of the data selected.
Win + BackSpacs - UNDD the last dumping action
O Wwhenthedive s bl (5) Manusly

() Data dumped alder than | 15 Day: v [ Concel l [ Save ]

If the iBin container exceeds the allocated space the Auto-Cleaner
deletes the data automatically. If you delete a file from the USB flash
drive, which is bigger than the size of the iBin container, it won’t store it
in the iBin.

iBin is a handy solution for Ontop Turbojet USB flash drives. It gives
you the peace of mind that there is a buffer between deleting files and
getting rid of them forever.

Download your free copy here.
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3. Counteracting known risks

USB flash drives have definitely made data transfer and storage very
convenient. To make the most out of these tiny yet powerful devices
it's important to understand the possible risks associated with using
them and to have knowledge of how to overcome those risks.

Getting a virus is perhaps the most common risk associated with USB
flash drives. Kids (and adults!) swapping games, images and files can
end up infecting the family computer. USB flash drives are often
connected to various mobile devices and different networks which
increase the chances of them being infected with viruses. So, how do
you protect your USB flash drive from viruses?
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Unfortunately, the Autorun of a USB drive may be where a virus can be
hidden. Windows uses Autorun to give you the option to explore, open
or copy the contents of a USB drive. If this is enabled, Windows will
read the flash drive automatically and inadvertently infect the computer
with the virus in the process. Disabling Autorun may prevent this.

It is important to scan your USB flash drive before transferring any data
to or from your USB flash drive. Most of the time this keeps your USB
drives clean. You can try various free antivirus software such as
Panda, Avast, and AVG.

Another possible risk for USB flash drives is the corruption of data. Do
you religiously follow the 'Safely Remove your USB Device'
instructions on your computer or other devices? If you are in the habit
of simply pulling out the USB flash drive from the USB port as soon as
you've finished, you could end up losing important data.
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Even if you think that you have closed all the files on the flash drive, it
Is possible that the device is still active in the background without any
visible indication. If you have important data on your USB flash drive
and no back up, you might lose the data. Disconnecting the flash drive
is so simple - right click on it and select 'Safely Remove Hardware' or
double click the icon in the system tray of your computer.

% atel m arda A
Select the device youwa e Stop a Hardware device
Windows notifies you tha
computer. Confirm devices to be stopped, Choose OK to continue.
Hardware devices: Windows will atternpt to stop the following devices, After tl

G& USE Mass Storage Device stopped they may be removed safely.

Q USB Mass Storage Device
< Generic volume - |:]
“#® Ontop USB Flash Drive

USB Mass Storage Device at Loé% ll

[ Propetties ][ Stop ]

[7] Display device components

Close

If you have lost data on a USB flash drive, there are various data
recovery tools and simple system tweaks to recover it.

What about data lost due to the loss of the device itself? A USB drive
carrying nearly 16,000 student and employee social security numbers
was stolen from Roane State Community College in Harriman,
Tennessee, causing embarrassment for authorities. Encryption of data
can prevent such data from being accessed, even if a drive is stolen.
There are free tools available to encrypt data on a USB flash drive.
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Plus, think about this—carrying USB flash drives in pockets makes it
easy to lose them; attaching them to bags, key chains or even wearing
them, makes them difficult to forget. A lot of Ontop’s designs come with
lanyards or keychains, or are specifically designed as pendants.

High data capacities along with high read and write speeds have made
USB flash drives undoubtedly the most convenient mobility device for
data storage and transfer. All the same, it's important to make sure you
keep them virus free, back up and encrypt so that you can enjoy them,
risk free.

[Image Sourcel] [Image Source?]

[Article Sourcel] [Article Source?] [Article Source3]
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4. How to format a drive with the NTFS file system

The most recent variants of Microsoft’s operating systems support
NTFS, an advanced file system. Here’s a way to format your USB flash
drive to the NTFS file system when it’s plugged into a PC running
Windows XP. By doing so you’ll enjoy better encryption and a boost in
performance of your USB flash drive.

Microsoft introduced NTFS, an advanced file system, with the
Windows NT operating system and continued using it in Windows
2000, XP and Vista. NTFS is a standard file system that supports high
performance, a self healing mechanism and file encryption. It also
offers file compression and auditing, thereby providing larger volumes
of storage than the older FAT file systems.

Format=Remoyabledliska ) J ai

Capacity:

1.87GB V]
File system

FAT32 &

FAT -

Default allocation size L‘_)

Volume label

Format options

[] Quick Format

[ Start ][ Close ]

If you format a USB flash drive with the NTFS file system, it will
increase the storage space by compressing the files. NTFS allows you
to encrypt data on files and folders with the help of Windows XP’s
integrated file encryption feature. The NTFS file system also allows
you to grant and deny permission for individual files and folders. You
can also set a disk quota.
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You can’t format USB flash drives with the NTFS file system in
Windows XP by default. But with a little tweaking, you can and here’s
how. Before you follow these steps, make sure your important data is
removed from the drive as the data will be permanently lost during
formatting.

Insert the USB flash drive into the USB port. Right click on ‘My
computer’ and then click ‘Properties’.

S piopeities ?][x]
System Restore ( Automatic Updates Remote ‘
, : Il Ll J
General Computer Name | Hardware Advanced

Device Manager

- The Device Manager lists all the hardware devices installed
- on your computer. Use the Device Manager to change the
properties of any device.

Device Manager. ? l
Drivers

@ Driver Signing lets you make sure that installed drivers are
& compatible with Windows. Windows Update lets you set up
how Windows connects to Windows Update for drivers.

[ Driver Signing ] [ Windows Update ]

Hardware Profiles

e Hardware profiles provide a way for you to set up and store
different hardware configurations.

[ Hardware Profiles ]

[ OK ][ Cancel ]

Select ‘Hardware’ and open ‘Device Manager’.

You can see the ‘Disk Drives’ tab here. Expand it to display all the
drives.
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T AEE

File Action View Help
- = HE @ m = ¥ &
= 2% GMws1
- j Computer _
[=]-%e» Disk drives lPdaﬁt Driver...
g Hitachi HDS721616PLA330 me ;
B SanDisk Cruzer USB Device
.49 WDC WD2500AAKS-60B3A0 5@ for hardware changes
- % Display adapters Properties

Select your USB flash drive and double click to open ‘Properties’.
Go to ‘Policies’. The selected default option will be ‘Optimize for
Quick removal’, change it to ‘Optimize for Performance’ and click
‘OK’.

[2]X]

Write caching and Safe Removal

(O Optimize for quick removal

This setting disables write caching on the disk and in Windows, so
you can disconnect this device without using the Safe Removal
icon.

(%) Optimize for performance

This setting enables write caching in Windows to improve disk
performance. To disconnect this device from the computer, click
the Safely Remove Hardware icon in the taskbar notification area.

[ Restore Defaults ]

WL o
[ ok j{ Cancel |
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Now close the window and open ‘My computer’. Right click on the
USB flash drive and select ‘Format’.

Details
Removable Disk (F:)
Removable Disk

Fie System: FAT32

The Format box will now have the option to format with the NTFS file
system or FAT and FAT32 systems. (The options would have been
limited to FAT and FAT32 if the steps above had not been taken).
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ag

Capacity:

. 1.87GB
. File system
‘ FAT32

p RN gt RSN o guiay o das. pral 4 prse
1 FormataRemoyablelliska(F)

| |FAT32
FAT

Volume label

Format options

[] Quick Format

|

Start

] [ Close ]

Select ‘NTFS file system’ and start formatting.

1.87G8

Fie system

Allocation unit size
Default slocation sze
Volume lzbel

Format options

[ Quick Format
[JEnable Compression

{ -
‘FormatBemoyable Diskd >

WARNING: Formatiing wil erase ALL data on this disk.
. To format the disk, dick OK. To quit, dick CANCEL.

[ st
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Now your USB drive will be formatted with the NTFS format.

JE3

Capacity:
File system

NTFS
Allocation unit size

Default aliocation size
Yome bhe Sormathine Remoyable:

-
Format options ‘\l') Format Complete.

Quick Format

Er.ab:e b

Create an M5-DQS stg

[--...-.......-.-...-------.-]

Start Cancel

With NTFS formatting, your files will be more secure and you can also
enjoy more space for your files and folders.
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5. How to keep your USB flash drive virus free

USB flash drives are the most convenient devices to use to carry and
transfer data. While they are really useful, they are also prone to
viruses. There are a few choices of major antivirus programs available,
unfortunately, many of them don’t detect viruses on removable drives
and may not permanently remove the viruses. USB Virus Scan is an
USB virus cleaner, one of the best available.

The best part of USB Virus Scan is that it scans the USB drive,
memory card and any storage media as soon as the USB drive is
connected. If Virus Scan finds any virus, Trojan or any other kinds of
threats, it cleans them immediately. The program scans the following
areas:

e Operating memory

e Local drives

e Removable media

USB Virus Scan is developed by USB Virus Scan International Inc and
you can download a trial copy from their website. The trial copy will
scan all the sectors of your computer including removable media, but
to remove it, you'll need to register the software. Registration costs
$25.95 and it’s just a onetime cost unlike other antivirus programs. You
don’t need to pay any renewal fee.

To install the program, double click the downloaded exe file and follow
these steps:
e Click ‘Next’
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(T

1’?3' Setup - USB Virus Scan

Welcome to the USB Virus Scan
Setup Wizard
This will nstal USB Virus Scan 2 3 on your computer

It is recommended that you close all other applications before
continuing

Oick Next to continue. or Cancel to exit Setup

|7 Next > | Cancel

e Select the ‘l accept the agreement’ radio button and click
‘Next’.

i) Setup - USB Virus Scan

License Agreement

Please read the following important information before continuing.

Flease read the following License Agreement. “ou must accept the terms of this
agreement before continuing with the installation.

END USER LICENSE AGREEMENT

m| »

1. Evaluation Version License - This agreement is a binding legal agreement
between USBANtVirus and the purchasers, users or evaluators of this Software.
You may use this Software only as descrbed in this agreemert. ff you do not agree
to the tems of this agreement, do not install the Softwane or use any registration
number that was provided with the Software.

2. Evaluation Version Distribution - This Evaluation Version of this Software shall not
be transfemed, sold, resold, offered for sale or distibuted in any way except in
accordance with paragraph 3.2 below. For information about redistribution of this

-

" | accept the agreement

@) | do not accept the agreement

< Back Mexd = Cancel
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e Use the ‘Browse’ button to select a different destination location
other than the default location (if required) and click ‘Next’.

License Agreement

Flease read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement befare continuing with the installation.

|END USER LICENSE AGREEMENT

mE

1. Evaluation Version License - This agreement is a binding legal agreement
between USBAntiVirus and the purchasers, users or evaluators of this Software.
‘You may use this Software only as described in this agreement. f you do not agree
to the tems of this agreement, do naot install the Software or use any registration
number that was provided with the Software.

2. Bvaluation Version Distribution - This Evaluation Version of this Software shall not
be transfemed, sold, resold, offered for sale or distibuted in any way except in

accaordance with paragraph 3.2 below. For information about redistribution of this &

71 | accept the agreement
@ | do not accept the agreement

e Click ‘Next’.

jﬂl Setup - USB Virus Scan

Select Additional Tasks
Which addtional tasks should be pefomed?

Select the addtional tasks you would like Setup to perform whie instaling USE Vius
Scan, then dlick Ned.

Addiional icons:
[¥] Create 2 desktop icon

[ o] [on ]
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e Click ‘Finish’ to complete the set up.

P
]5] Setup - USB Virus Scan ] S

Completing the USB Virus Scan
Setup Wizard

Setup has finished instaling USB Virus Scan on your computer
The application may be lsunched by selecting the instaled
icons

Cick Firish to exd Setup.

¥! Launch USBScan

-~

USB Virus Scan will then launch.

Its interface is compact and simple unlike other antivirus programs like
AVG.

z oy

(¥ Scan targets:
—
SCaN : D'c[;rh.:e
Process | Removable Media
Tools ~
Immunity
Fixzystem
Settings
Update
Fegister
About v
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When you launch the program for the first time, it is advisable to
perform a full scan of your system, including operating memory, all
local drives and any removable media. If the scan detects any virus,
clean the infected files immediately.

) F——

/!} Threat is detected in usb drive, select an action

Avaiable actions

O dean infected files only

(O Open usb drive safely

(® Clean infected files and open usb drive safely

[JDon't show this again. [ fok | [ cancel |

irus Scan V2.3 (Full Version m

L i Scan targets:

| 1
— | Operating Memory |
Secan [ Local Drives

Removable Media

Frocess

Tanl 1A\UiBright_Antivirus.vbs cleaned
nois IAAutorun.inf cleaned
Immunity | J:\ cleaned completed.

FixSystem
Setings Scan completed successfully
Update

Fegister
About M

LizgGa= | |

From the next time onwards you won'’t need to scan the removal drives
manually, as USB Virus Scan will automatically scan your removable
drives as soon as you connect them to your computer. This will mean
that you'll be able to plug in a USB flash drive of a friend or colleague
without worrying about whether or not it contains a virus. If it does,
USB Virus Scan will find it and deal with it immediately.
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6. How to set up an MP3 player on your USB drive

Winamp is a very mature free media player and with it and an Ontop
USB flash drive, you can create a portable media player with your
collection of MP3s that can then be used hassle free between
computers.

The Winamp Media Player program is only 10.3MB, so it’s easily
stored on a 4GB (or larger) Ontop USB flash drive. Winamp music
doesn’t require a lot of memory and it plays all widely used audio and
video file formats. To install the Winamp Media Player on your Ontop
USB flash drive, download the free software to the hard drive of your
computer. | used Winamp Media Player version 5.47.

Language Detected: Engliéh v

Winamp Standard

FREE
File size: 10.3 MB

I:] Include MP3 Bundle (File Size 15.7 MB)
Viewy list of bundled MP3's

-

Install to the default folder c:\Program Files\Winamp on the computer
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Winamp Installer

Choose Install Location

SOVIDIARTID oo o fekcr it ot Wi,

The installer has determined the optimal location for Winamp. If you would like to change the
folder, do s0 nows.

Space avalable: 1,.5G8

[ <sack || mex> | [ coxe |

Plug your Ontop USB flash drive into the USB port of your computer.

Go to the c:\Program Files\Winamp location on your computer and
copy the Winamp folder to USB flash drive.

@ Removable Disk (H:)

Fle E Vew Favortes Took Hep

Qe - ) T Jsewch | Fdes [T K8 Fodersmc

Aodress | L 1)

e . N 23 Mruses
®,) Music Tasks '/l Winame @J ARN | .}' ’
aLonun - bius raght
P >
ey

i -
iia—ors @) ©) o i
o Mate a naw folder chroche ! re

bad Share this fuidee 2™ ke W astrescrt mp (sudio mpeg
) e By 5

Next you have to create a Winamp.cmd file inside the Winamp folder
on the USB flash drive. To create a Winamp.cmd file, open a new
Notepad file and type in the following text:

start Winamp.exe /inidir=ini
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start winamp.exe /inidir«ini

Save As 215
Saverc () Deshaco v O E
My Documents
3 E, i My Computer
My Recent !gm Network Places
Documents  jawsomemaloftheday__p
03] 22_Feb_Shanzs_Bockameding
8 &) account
Deskiop 2 account for bookmarking
2 book 1
) book 17
J &) book 18
MyD . Ebook1e
My Computer
Q Fie pame Y =
MyNewok  Saveathpe  Tewt Documents (" bd) v
Encoding ANSI v

In Notepad, select File > Save As and save the file using the name
winamp.cmd. To do this you will need to change the default file
extension .txt to .cmd. You can now close Notepad.

Now double-click on the winamp.cmd file you've just created. This
will open the Winamp Setup window.
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=
File and Folder Tasks i~ ini
[ﬂ Rename this file
Mave this File (=
a — Skins

Copy this file
&) Publish this file to the Web
() E-mail this file

: libFLAC. i
iy Print this file

K Delete this file

nscrt.dll

Other Places

{29 Removable Disk (H:) Q primosdk.DLL

L) My Documents
() Shared Documents
W My Computer

& My Network Places

Ninamp

Windows NT Command Scripk
1 KB

On the step 2 of the Winamp Setup window, uncheck all of the file
types that can be associated with Winamp.

Fle Navigation o - Hep

Sedect the file types you want to be associsted with Winamp.

+ [
# [ Playhsr Flies
# [[] video Files
@ [[] Winamp Speciic Fles
[[] Launch Winamp for Audio CDs

[V] Show Winamp in Folder context menus in Windows Explorer,

[¥] Enable Winamp Agent
Mantains your fle associations with Winamp (recommendad),

[ 8ok | [ met ][ Fosh |

Uncheck all of the file types
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In the last step of the Winamp Setup window make sure you uncheck
the ‘Yes, allow anonymous usage statistics (recommended)’. If you
leave it checked Winamp will be sending periodical reports of the
application to you via email.

After you click Finish, the Winamp Portal pops up with a message at
the centre Add Media to Library. You can close the message and
then copy your Playlist from your personal computer to your USB flash
drive.

@ WINAMP

e - Aol Music.

FIFSImrar we e o
# Add Media to Library X

Media Library Video

- ] You have no kems in your meda lbrary, To add items,
chck the Add Meda to Lbrary button below

« ALICHO

[ Add Media to Library J

100 ot show me this again

Learn More About Winamp

Close the Add Media to Library window

After doing all of this, every time you want to listen to your favourite
songs on different computers, go to your Winamp folder on your USB
flash drive and double click the Winamp icon to open the Winamp
portal.
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- pnmosdk DLL |
3.17.92.301 ﬂ, tataki.di
F”r”" ftware Development Kit

-, UninstWa =  whatsnew
' Winamp Installer = T T ['n:u:urx'nant
Mullsoft, Inc. =

Wlna p inamp
Windows NT Command Scripk inamp

1 1KB Jullsoft, Inc.

Wlnam | o

Winamp Agent .‘% zlib.dll

Mullsoft, Inc.

Double click on the Winamp file

Go to File > Play File and then select or queue the media files on your
portable Winamp player to play your music files.

Play Fie... L
Play URL... CErL

Play folder... Shift+L % WINAMP

Play bockmark Aol Music.

Open playlst Ctr4+0
Save playlist Cers

Add Media to Library..,

View fle info...

Exit

Click Play file or press L on the keyboard

Page 35 of 55

Copyright©2010 www.ontop-tech.com and www.metaplume.com




The Top Ten USB Flash Drive Tips

ontOr

Fite” Play Options “iew Help Go Pro

1son & Cynitia Suite (5:1

Media Library Vi % Open file(s)
E Nowy Playing

Look in: ;] Removable Disk [H:]

: ) Winamp
X9 & 3 Jason  Cynitia Suite
My Recent u 3|d|0t501(www.sonqs.pk)
Documents

Winamp’s interface showing the song names, etc

By loading the portable version of Winamp Media Player with audio
files onto an Ontop USB flash drive, you can carry your own music
library with you and listen to them on any computer without having to
worry about whether or not that computer has a media player installed.

The excellent read speed of Ontop TurboJet USB flash drives ensures
that music playback is always smooth.
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7. How to run portable apps from USB flash drives

Life becomes a lot simpler when you can travel light with your little
netbook or notebook and a USB flash drive, which can literally carry
your entire digital world. The PortableApps.com Suite allows you to run
applications directly from your USB flash drive, without the need for
installation. Here's what this suite has to offer.

The PortableApps.com Suite offers a collection of portable apps, which
are preconfigured to work from portable devices such as USB flash
drives. The suite includes portable versions of Mozilla Firefox for web
browser, Mozilla Thunderbird for email client, office suite, Mozilla
Sunbird for calendar/scheduler, Pidgin for instant messaging, Clamwin
for antivirus, CoolPlayer for audio player, Sudoku game, KeePass
Password Safe for password manager, Sumatra PDF for PDF reader,
minesweeper clone, backup utility and integrated menu.

(& PorTaBLEAPPS.COM

) damWin Portable
J CoolPlayer+ Portable
(@ KeePass Portable
-1 Mines-Perfect Portable
@ Mozilla Firefox, Portable Edition
& Mozilla Sunbird, Portable Edition
€9 Mozilia Thunderbird, Portable Edition
[@ openoffice.org Base Portable
OpenOffice.org Calc Portable
[} openoffice.org Draw Portable
OpenOffice.org Impress Portable
3 openoffice.org Math Portable
[ openoffice.org Writer Portable
5 Pidgin Portable

“ PhNotes Portable

| Sudoku Portable
f® Sumatra PDF Portable

Documents

n
n
"
P
B
M
i
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You can install the PortableApps.com Suite and Platform from its
homepage here http://portableapps.com/

Hgme

;ErtableApps.com Suite and PortableApps.com Platform

your computer, without the computer™

PortableApps.com Suite™ is a complete collection of portable apps induding 3 web browser,
amai chant, office sute, calendar/scheduler, instant messaging chent, antwvirus, audio player,

sudoku game, password manager, PDF reader, minesweeper done, backup utiity and
integrated menu, all preconfigured to work portably. Just drop it on your portable device and you're ready to go.

A ———
Choose Your Download

Croose Your Dostiosd (Do Not Right Tl
Downioad Details

Clicking the download button gives you the option of installing only the
platform or one of the two suites, Suite Light and Suite Standard.

Suite Light replaces OpenOffice with AbiWword Portable. Suite Light can
be installed on a 256MB+ devices and Suite Standard requires
512MB+ devices. You can download a suite of your choice. You need
only to add the apps of your choice.

Platform Only Suite Light Suite Standard

N ‘ ™ o B W
Download Download Download

353 152 1.5.2
1MB download 46MB download 124MB download
1.3MB installed 150MB installed 355MB installed
All devices 256MB+ devices 512MB+ devices

Multilingual English Enalish

Install the suite in the root directory of your USB flash drive.
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K’) Portablefippecomstited \Portablenppeiconinetallern

Installing
Please wak while Portablefpps, com Suke is being instaled.,

Extract: mineperf.exe
[m TTIT) )

Now you can simply plug in your USB flash drive to launch the apps
when you need to, and unplug it when you are through. It's that simple.

You can use the apps and delete those you don't need.
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8. Your customized desktop on a flash drive

When you work between a desktop and a notebook, or between an
office PC and a PC at home, don’t you wish you could be working with
the same desktop, setup just the way you like it? That is now possible

with MojoPac.

MojoPac is not a remote access or desktop sharing software, it's
virtualization software which lets you carry a customized version of
your desktop on your USB flash drive so that you can view it on
multiple systems.

.. ,
SNuUEL )

«

The virtualization software, from RingCube technologies, creates an
extra desktop on a USB flash drive. You can load most of your favorite
apps on a virtual desktop and enjoy them by just plugging in the flash
drive to multiple systems.
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MojoPac software can be downloaded from the MojoPac website; the
setup file is 21.6MB. During the installation process, select your Ontop
USB flash drive as the location to install MojoPac.

L4 MOJO|PAC

Try MojoPac today
and take your Mojo with you
any time, anywhere, on any PC!

O Kl 7

L4 about mojopac download J
\

After the installation process, a virtual XP desktop will be created on
the USB flash drive. By default it will include Internet Explorer, Outlook
Express and Windows Messenger, along with My Documents, My
Pictures and My Music.

Next, register at the MojoPac website and create a username and
password for the MojoPac desktop.
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MojoPac Installation - Install

L MOJO|PAC

14% - Complste

« License Agreement
“""" « Install Options

: » Install
A AASS 17
1Y) viOJ0O pAC
Ib e rmnesarst i .

McjoPac Virtual Deskiop Enviroment J J \/ Information

MojoPac is now being installed. After the
Endpant Security Features J task completes, please click Finish
Shared Clpboard and POF Prn
Support = J
Configarable Auto-Updates and J
E-mas Sgnature
Technical Suppont J

Please visit for more details.

The whole interface is fantastic and can be easily customized to suite
your needs and style. It has a task bar, start menu, icons, and desktop
shortcuts, all very familiar to an XP powered computer.

Software, desktop apps, and files can be uploaded directly from the
host computer. When you plug in your USB flash drive with MojoPac
installed there will be two desktops and two ‘My Computer’ sections.
Similarly, there will be two kinds of drives, those on the host computer
drive and those setup as the MojoPac drives. A person working on the
desktop of the host computer can access all the drives of MojoPac
desktop, but someone working on the MojoPac desktop from a USB
flash drive can only access limited drives of the host computer via the
MojoPac desktop.
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Evoome by [ ) 107 x

L] MoJo|rAC

Lo mptend st ncipacin: O EMo

You can customize the desktop wallpaper and other settings, just like
any other desktop. Music, video, and games can be uploaded to the
MojoPac desktop. You can also upload software like RealPlayer,
games, Firefox and web messengers.
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Another benefit is that the USB flash drive is not blocked and can be
still used for data transfer. But the best part is that the host computer is
not stalled; it is easy to swap between host computer and the MojoPac
desktop at anytime; there is a switch button near the top. The only
disadvantage is that it’s a bit slow since the whole interface is
operating from a USB flash drive. To speed it up you’ll need a high
speed USB flash drive such as Ontop flash drives powered by
TurboJet technology. Ontop USB flash drives with TurboJet are three
times faster than standard USB drives, providing a faster work
experience with the otherwise slow MojoPac.
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L. MOJO|PAC
od g
Google Chrome . RealFlaver . Now Playing

Document

@ Internet J My Documents
Goagle Chrome ‘
. F Bya ¢ ()| mp3 |128 Kbps
My Recent Documents »
&5 E-mail Lab 4
UJ' Outlook Express o
] My Pictures
b g
4‘8 Windows Messenger =/ My Music

MojoPac is a great way of carrying around a customized and familiar
desktop so that you can use it on any PC. There is a lot of advanced
virtualization software available in the market like Ceedo and VMware,
but they have certain limitations. Ceedo requires you to purchase
another product, Argo, to run a targeted application without
modification. VMware is the best virtualization software out there, with
many advanced features and support for different operating systems,
but it is also a very expensive product costing nearly USD 6000.
MojoPac is a great portable desktop option as it supports most popular
software and replicates an entire desktop—plus, it’s free!
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9. How to get more space on your hard drive

There are a lot of disk cleaning software utilities available for analyzing
disk usage and cleaning up folders. Making more space available on
your hard drive helps to get the best performance out of your
computer. Part of the process is to analyze how much space you have
and which files or applications are using up your precious hard drive
space. WinDirStart does all this and also cleans up your drive. Best of
all it's a portable app for Windows which can run straight from a USB
flash drive.

You can download the free application from portableapps.com.

WinDirStat Portable

know what's on your drive

WinDirStat Portable 1s a disk usage analyzer and cleanup tool packaged as a portable app, so you
can see axactly what's on your davice ar 2 host computer’'s hard drive and easidy free up space

Article 7 in this e-book gives an overview of the Portableapps.com
suite. If you already have the portableApps.com suite on your USB
flash drive, click 'Options’ on the PortableApps.com Menu and select
‘Install a New App' to add WinDirStart to your suite.
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o PORTABLEAPPS.COM
YOUR DIGITA IFE. ANYWNHER

) ClamWin Portable Oocuments
. ConvertAll Portable
J CoolPlayer+ Portable
(8) KeePass Portable Pictures
-1 Mines-Perfect Portable
& Mozilla Firefox, Portable Edition
& Mozilla Sunbird, Portable Edition
&) Mozilla Thunderbird, Portable Edition B Backup
OpenOffice.org Base Portable
) OpenoOffice.org Calc Portable @ Smal Fonts g
E, OpenOffice.org Draw Portable Large Fonts
OpenOffice.org Impress Portable ~ Instal aNewApp
OpenOffice.org Math Portable Refresh App Tcons
OpenOffice.org Writer Portable Siek Mors. Apps..
(5 Pidgin Portable Languags

“ PNotes Portable

. Sudoku Portable
(@ Sumatra PDF Portable

Music

Yideos

Explore

Select the downloaded portable .paf.exe file you just downloaded.
WinDirStart will be automatically added to the menu.

OpenOffice.org Math Portable
OpenOffice.org Writer Portable
3 pidgin Portable

” PNotes Portable

- Sudoku Portable
€, Sumatra PDF Portable
#§ winDirStat Portable

Drive (C3)
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You can also install it separately, as a standalone app that’s not part of
the suite. Now you can browse all of the folders on your computer and
see what is really taking up all the space.
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You'll be surprised to find unnecessary files and applications which are
otherwise hidden. It actually breaks down the results of the analysis in
a colorful, easy to understand manner. You can track almost all files.

Clicking 'Options' on the menu allows you to check out free space,
see the file types, and a lot more. You can also view the files in
Directory list, Treemap and Extension list.

The 'Clean up' option offers you various options to remove unwanted
and unused files.
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If you thought running applications from a USB flash drive would take a
long time, check out Ontop’s flash drives with ultra fast TurboJet
technology. The technology offers high read and write speeds to all its
USB flash drive designs and even makes playing HD videos easy.

Little apps like WinDirStart on your USB flash drive, make flash drives
more than just portable storage devices.
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10. Email on your USB flash drive

Mozilla are the creators of the widely popular browser, Firefox. They
have also developed an email client called Thunderbird. Thunderbird is
a robust and reliable email client, with many advanced features and it
can be used on the move from a USB flash drive! Here's how.

You can download the portable version of Thunderbird from the
portable apps website.

Mozilla Thunderbird, Portable Edition

real email, on the go™

Mozila Thunderbird®, Portable Edition s the popular Mozilla Thunderbird emaid dient
bundied with a Portabledpps.com launcher as a portable app, S0 you can take your email,
address book and account settings with you, You can 3lso add in GPG and Enigmad to
encrypt and sign your email.

Download 3.0.1

To install Thunderbird Portable on your USB flash drive, double-click
the downloaded installer file and select your USB flash drive as the
location to install the application and click ‘Install’.

L ooz lladtindenbird, Portable Edition OTEabIERpPEConTINE S .j Jm‘

Choose Install Location Q

Choose the folder in which to install Mozilla Thunderbird, Portable
Edition,

Setup wall Install Mozilla Thunderbird, Portable Edtion in the Following Folder. To instal in a
dfferent folder, click Browse and select another Folder. Click Install to start the installation.

Destination Folder

Space required: 23.0MB

[ <Back |[ mstat | [ cancet |
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This will create a Portable Thunderbird directory and associated files
on your flash drive.

= i hunderbirdPortable)
Fle Edt View Favorkes Tools Help »
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Address () F-\Harsha\Portable\ThunderbirdPorable
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- help.html
HIML Document
9KB

ThunderbirdPortable exe
Mozila Thunderbird, Portabie ..,
PortableApps.com

Double click the .exe file to get started.
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In an earlier article we discussed the portable apps suite, which has a
huge list of goodies that can be used on USB flash drives. The
PortableApps.com Suite includes Mozilla Thunderbird by default.

G PorTasLEAPPS.COM

() ClamWin Portable
. ConvertAll Portable
J CoolPlayer + Portable
(@) xeePass Portable
-1 Mines-Perfect Portable
& Mozilla Firefox, Portable Edition
& Mozilla Sunbird, Portable Edition
() Mozilla Thunderbird, Portable Edition
E OpenOffice.org Base Portable
E OpenOffice.org Calc Portable
Ej OpenOffice.org Draw Portable
OpenOffice.org Impress Portable
E OpenOffice.org Math Portable
E OpenOffice.org Writer Portable
£5 Pidgin Portable

“ PNotes Portable

- Sudoku Portable
@ Sumatra PDF Portable

Portable Thunderbird simply works like any application on your hard
drive. With the portable edition of Mozilla Thunderbird, your email,
address book and account settings are always available to you on your
USB flash drive. Thunderbird supports email services such as Yahoo,
Hotmail, MailDotCom, Gmail, Libero, and AOL.
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You can manage multiple e-mail, newsgroup and RSS accounts and
identities with Thunderbird. If you wish to upgrade Thunderbird, you
only need to install a new copy over the existing one. This will preserve
your data. Thunderbird will also work from a write-protected USB
flash drive. [Note: Thunderbird will not automatically save addresses
to the address book].

The advantage of using Thunderbird Portable from a USB drive is that
it does not leave any data behind on your netbook or notebook. All the
data remains on the USB flash drive. You can easily access your
emails from any server provider (like Hotmail, Yahoo, Lycos, mail.com,
Gmail, and AOL) both online and offline with Thunderbird Portable.
Although an offline version of Gmail is available, it is in experimental
stages and could still have a lot bugs. In addition to this, accessing
Gmail offline requires the installation of Google Gears on your netbook
or notebook. Offline Gmail running from a USB drive is not available
yet. However, in the case of Thunderbird Portable, the software is
installed on the USB flash drive and does not require the installation of
any software on your notebook.
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Please note that it is important to change the default Thunderbird
settings from “download and remove your mail from the server” to
“keep a copy of all emails in the server” so that all emails will be
available online and for downloading on other computers. Make sure
that this is done before you download your emails to Thunderbird
Portable.

While Mozilla Thunderbird Portable allows you to enjoy its features on
the move, high speed USB flash drives such as Ontop USB drives
powered by high speed TurboJet technology will ensure that you will
not have to compromise on the speed or quality of these applications.
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iBin

A tiny application to create a portable Recycle Bin for USB flash
drives.
http://www.autohotkey.net/~FirstToyLab/project_iBin_download.htm

USB Virus Scan

A USB virus cleaner for scanning for and cleaning up viruses and
Trojans on portable storage media.
http://usb-virus-scan.software.informer.com/2.3/download/

Winamp

Winamp is a portable media player, which supports most popular
audio and video formats.
http://www.winamp.com/media-player/en

PortableApps

A collection of apps and important software in portable format, which
can work from a USB flash drive with ease, including browsers,
email clients, office suite, calendar/scheduler, instant messaging
clients, antivirus, audio players, and even a Sudoku game.
http://portableapps.com/

MojoPac

Virtualization software, allowing you to carry a customized version of
your desktop on a USB flash drive.

http://www.mojopac.com/

Mozilla Thunderbird
Free, open source email and news client with advanced features.
http://en-us.www.mozillamessaging.com/en-US/thunderbird/

WinDirStart

Portable software used to analyze, manage and clean up file
management on a computer.

http://windirstat.info/
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